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Brief Introduction to R

1 R for your PC at home

R is a programming language and software environment for statistical computing and graphics. R

was created by Ross Ihaka and Robert Gentleman at the University of Auckland, New Zealand, and

is now developed by the R Development Core Team. R is a free software, which can be downloaded

from

http://www.r-project.org/

The webpage also contains documentation and useful contributed extension packages.

2 Starting R and Finding Documentation

Select R from the ”All Programs” menu list or click the shortcut. Online documentation as well as

an introduction in PDF format can be accessed via the Help menu. For short computations use the R

Console. To give R a trial enter sin(4)+pi and press ”Return” on your keyboard. In case of more

elaborate studies open the ”R Editor” by entering the File menu and clicking on New script. Type

your commands in the file and execute by highlighting them and pressing ”F5” on the keyboard. Try

this with sqrt(4)+sum(c(7,4,56))+seq(1,6,by=2). To save the file call the File menu and select

Save.

3 Importing Data in R

Download the files ”studentdata.csv” and ”studentdata.txt” from the course homepage and store them

to your computer. To familiarize with the data open the first file with Excel.

In R data from Excel is imported using the read.csv2 command. In order to store the data to your

R workspace you select an appropriate name and assign the data to this variable by typing

data.student=read.csv2("C:/.../studentdata.csv").

To look at the data, type data.student and execute. It is also possible to import text files using

data.student=read.table("C:/.../studentdata.txt", header=TRUE, dec=",", sep="\t").

To find more information about the parameters header, dec, sep and how to export data, start the

online help with help(read.table), help(write.csv), help(write.table) respectively.

You can also find the data we just used in the R-package ”LearnBayes”. To load the package and the

data implement

library(LearnBayes) # loads the package

data(studentdata) # loads the data

help(studentdata) # gives information about the dataset

attach(studentdata) # makes the names of the variables known in the R enviroment.
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4 Exploring datasets

4.1 Information about the dataset

If the data is loaded from a R-package you can call the online help to get an impression on what the

data is about. The functions names, str and summary give you an idea of the variables stored in any

data frame.

help(studentdata) # description of the variables

names(data.student) # returns the variable names

str(data.student) # displays the internal structure of an R object

summary(data.student) # produces summaries of the data

Squared brackets are used to access components of data frames:

data.student[1,3] # returns the component of the first row and third column

data.student[1,] # returns the first row

data.student[,2] # returns the second column, i.e. variable Height

Height # returns the variable Height.

4.2 Summarize and graph data

As a first example we analyse the students’ drinking preference. The variable Drink has an ordinal

skale with 3 levels. To display the levels and their occurence use the table command and generate a

barplot.

table(Drink)

t=table(Drink) # the output of table is stored in the variable t

barplot(t, xlab="Drink", ylab="Count", col="red") # produces a barplot

For variables with numerical values use a histogram for graphical representation. To investigate the

question of how long the students have slept the previous night, you can use the following code:

hours.of.sleep=WakeUp-ToSleep # hours of sleep are computed

summary(hours.of.sleep)

hist(hours.of.sleep, main=" ", freq=FALSE) # plots a histogram.

4.3 Compare data and study relationships

We want to explore, if men pay less for a haircut than women. A graphical way to compare datasets

is the boxplot, which is computed by

boxplot(Haircut~Gender, ylab="Hours of Sleep") #produces two boxplots distinguished by Gender.

To select only certain components of a vector logical operators like ==, <, &, >= are needed.

Gender=="female" # returns a vector of the same length as Gender with values TRUE and FALSE

Haircut.female=Haircut[Gender=="female"] # selects the haircut prices only for female students

Haircut.male=Haircut[Gender=="male"] # selects the haircut prices only for male students

We can now compute seperated statistics for men and woman:
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summary(Haircut.female)

summary(Haircut.male).

To investigate the relationship between two interval scaled variables, you can make a scatterplot and

fit a regression line. This is demonstrated by dealing with the question if the length of sleep is related

to the time he or she goes to bed.

plot(ToSleep, hours.of.sleep) # scatterplot

plot(jitter(ToSleep), jitter(hours.of.sleep)) # jitter adds a small amount of noise

fit=lm(hours.of.sleep~ToSleep) # fits a regression line by least-sqares method

abline(fit) # adds the regression line to the plot

5 Functions in R

5.1 Generating random samples

In R you can sample from many different distributions. With

N=10

x=rnorm(N, mean=50, sd=10)

y=rbinom(N, n=6, p=0.5)

you receive two samples of size N = 10, where x is sampled from a normal distribution and y from

a binomial distribution. Further available distributions among others are Beta-distribution (beta),

Exponential-distribution (exp), Student’s t-distribution (t) and Uniform-distribution (unif). To sam-

ple from them put a ”r” in front, to obtain the density/probability at a specific point a ”d”/”p” and

to receive a quantile a ”q”. To get more details concerning the arguments call the online help, e.g.

help(qexp).

5.2 Basic functions in R

Implemented functions in R are for example length, var, sd, median, quantile, cos, min, prod,

sort and sum. For more information refer to the online help.

5.3 Writing your own functions

We will write a function to compute the value of the t-statistic for samples x1, ..., xm and y1, ..., yn.

The t-statistic is defined as

T =
X − Y

sp
√

1/m+ 1/n

with pooled standard deviation

sp =

√
(m− 1)s2x + (n− 1)s2y

m+ n− 2
.

In R we will name our function tstatistic and define it as a function with two arguments, the

vectors x and y. The output of the function (indicated by the return statement (see the R code

below)) is the value of the t-statistic.
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tstatistic=function(x,y)

{

m=length(x) # assigns the size of x to m

n=length(y) # assigns the size of y to n

sp=sqrt(((m-1)*sd(x)^2+(n-1)*sd(y)^2)/(m+n-2)) # computes the pooled standard deviation

t=(mean(x)-mean(y))/(sp*sqrt(1/m+1/n)) # computes the t-statistic

return(t) # returns the value of the t-statistic

}

You can try the function by simulating some data for x respectively y and computing the t-statistic

using these data:

data.x=rnorm(n,50,10)

data.y=rnorm(n,50,10)

tstatistic(data.x, data.y).

6 Program a Monte Carlo Simulation

Suppose we are interested in learning about the true significance level αT for the t-statistic when the

population does not follow the standard assumptions of normality and equal variances. Therefore we

want to estimate

αT = P (|T | ≥ tn+m−2,α/2)

with particular choices of the significance level α, the distributions of the samples and the sample

sizes. Here is an outline of a simulation algorithm to compute αT :

• Simulate a random sample x1, ..., xm from a first population and y1, ..., yn from a second popu-

lation (be reminded that the two means of the populations have to be equal).

• Compute the t-statistic T from the two samples.

• Decide if H0 is rejected, i.e. does |T | exceed the critical value?

One repeats steps 1-3 of the algorithm N times and estimates the true significance level by

α̂T =
number of rejections of H0

N
.

The R code looks as follows:

alpha=.1; m=10; n=10 # sets alpha, m, n

N=10000 # sets the number of simulations

n.reject=0 # counter of number of rejections

for(i in 1:N)

{

x=rnorm(m,mean=0,sd=1) # simulates from population 1

y=rnorm(n,mean=0,sd=1) # simulates from population 2

t=tstatistic(x,y) # computes the t statistic

if (abs(t)> qt(1-alpha/2,n+m-2))

{n.reject=n.reject+1} # rejects if |t| exceeds critical value

}

true.sig.level=n.reject/N # estimates the proportion of rejection.



Applied Bayesian Inference A Brief Introduction to R, KIT WS 2010/11 5

QUESTIONS

1. Repeat the Monte Carlo Simulation for other populations, e.g.

x=rnorm(m,mean=0,sd=1); y=rnorm(n,mean=0,sd=10)

x=rt(m,df=4); y=rt(n,df=4)

x=rexp(m,rate=1); y=rexp(n,rate=1)

x=rnorm(m,mean=10, sd=2); y=rexp(n,rate=1/10).

Compare the estimated true significance levels with the stated significance level α. How do

variations of the normal distribution affect the true significance level? How does different choices

of distributions effect αT ? How does different spreads and shapes between the two populations

influence αT ? (To examine how much the distributions differ in shape visualize the distributions

using the curve command.)

2. The variable Job contains the hours of work on a job per week.

(a) Analyse Job by the summary command and graphically by a histogram. To construct a

meaningful histogram use the parameter breaks.

(b) Construct a boxplot from the Job data and distinguish by the levels of Gender. Use the

parameters col, ylab and main. After plotting, assign the boxplot to y1

y1=boxplot(...)

and call y1. What statistics are given? How big is the difference between both medians?

(c) On average, how much more do the boys work than the girls? To answer the question, use

the mean command, but remember that the mean is not robust against outliers. Therefore

you should remove the biggest data point in Job and store the new vector to Job1. Job1

and Gender now differ in length, hence remove the appropriate data point from Gender too

and store the new vector in Gender1.

Then try to compute the means by using the data from Job1 and Gender1. Why does it

not work? Use the parameter na.rm to solve the problem.

3. Suppose you observe y that is binomially distributed with sample size n and probability of

success p. The standard 90% confidence interval for p is given by

C(y) = (p̂− 1.645

√
p̂(1− p̂)

n
, p̂+ 1.645

√
p̂(1− p̂)

n
),

where p̂ = y/n. This procedure is used under the (false) assumption that

P (p ∈ C(y)) = 0.90 for all 0 < p < 1.

Let us investigate if the probability of coverage P (p ∈ C(y)) is really 0.9 for all p and n.
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(a) The function binomial.conf.interval will return the limits of a 90% confidence interval

given values y and n. You can find the function binomial.conf.interval in the file

”BinomialConf.txt”, which can be download from the course homepage. Open the file and

copy and paste the text into R.

(b) Suppose that samples of size n = 20 are taken and the true value of the proportion is

p = 0.5. Simulate a value of y and use binomial.conf.interval to compute the 90%

confidence interval. Repeat this a total of 20 times and estimate the true probability of

coverage P (p ∈ C(y)).

(c) Suppose that n = 20 and the true value of the proportion is p = 0.05. Simulate 20 binomial

random variables with n = 20 and p = 0.05 and for each simulated y, compute a 90%

confidence interval. Estimate the true probabilty of coverage. Repeat this for n = 40. Do

the estimated true probabilities of coverage match 0.90?

4. Exercise 3 demonstrates that the actual probability of coverage of the traditional interval de-

pends on the values of n and p. To investigate how the probability of coverage depends on the

sample size and true proportion value let n be 10, 25, 100, and p be 0.05, 0.25, 0.5.

Write an R function that has three inputs: n, p, and the number of Monte Carlo simulations N,

and will output the estimate of exact probability. Implement your function using each combina-

tion of n, p and N = 1000 simulations. Describe how the actual probability of coverage of the

traditional interval depends on the sample size and true proportion value.


